ADOBE ILLUSTRATOR CS HELP



Useful help function terms: Help>lllustrator Help (F1) > search for ...

As you probably know, one of the hardest things about learning new software is knowing what things are
called. If you know the term (that in illustrator a vertex in a line is called an “anchor” point, for example)
you can search the help and get useful advice.

1. Fill and Stroke Controls

2. Stroke an object (pull down to the right lets you “show options” and set a dashed line is desired)
3. Pathfinder panel overview

4. About paths

5. Drawing > Drawing with the Pen tool

6. Drawing > Editing paths

7. Convert type to outlines

8. Place (import) files

9. Trace artwork

10. Align and distribute objects

11. Change the color mode of a document

12. Create Blends > Create a blend with the Blend tool

13. Control panel overview (set the fill colour in the box indicated by the letter “A”, the stroke colour
immediately to the right, the default stroke is set to 0.025mm indicated by the letter “B”)

14. Methods for cutting, dividing, and trimming objects



KILLER TIPS



The following images are taken from a very useful book on learning Adobe lllustrator. Each tip has a title
and an explanatory image associated with it ... but if you read the tips closely they'll often give you useful
information about a related task.
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® © © STARTOVERAGAIN

[f you have changed the ruler origins (see previous tip) and _
want to put them back to the default setting, double-click (
on the top-left comer between the two rulers.

® ® ® CHANGE RULER MEASUREMENT

The unit of measurement in [llustrator is determined in the Pref-

erences (Mac: llustrator>Preferences; PC: Edit>Preferences). This —‘i Points b?—

will affect all aspects of the program that use measurements, Picas
including the rulers. However, if you need to quickly override the

current unit, just Control-click {PC: Right-click) anywhere an the ¥ Millimeters
ruler and choase your new unit of measurement. Centimeters

Pixels
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® ® © CHOOSE THE BEST SELECTION TOOL FOR THE JOB

Trying to determine when to use the Selection tool versus the Direct Selection tool? Here's a
simple suggestion: Think of the Selection tool as the “move” tool and the Direct Selection tool
as the “reshaping” tool. Actually, | suppose that the Selection tool should be thought of as
the move/resize tool, since those are the two functions it performs. So, anytime you need to
decide between tools, ask yourself: Do | need to move/resize the object, or to reshape it? That
will help you pick the correct selection tool.
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® ® & quICKCHANGE TOOL

If you need ta use the Selection tool and then return to the tool you were
using, here’s how to do it. With any tool selected, press-and-hold Command
{PC: Control) to tempararily activate the Selection tool. (Actually, it will
activate the last selection tool you usad, so you may get the Direct Selec-
tion tool.) Once you've used the Selection tool, let go of the key to return
to whatever tool you had been using.

® ® ® MEMORIZE THESE LETTERS

In the good old days of llustrator, you could press Command-
Tab (PC: Control-Tab) 1o switch between the Selection and Direct
Selection tools. As of 05 X on the Mac, this shortcut doesn’t work
anymaore, 50 to switch between the two selection tools, you'll have
to press “v” for the Selection tool and "a” for the Direct Selection
tool. PC users have a choice of pressing Contral-Tab to switch
between tools or pressing “v" or "a”,
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® ® @ DON'TCLICK ON THE ZOOM TOOL

Rather than moving all the way
over to the Toolbox to click on the
Zoom tool, press Command-Space-
bar {PC: Contral-Spacebar). This will
“interrupt” whatever tool you are
using and activate the Zoom tool.
Click to zoom in, then release the
keys to retumn to whatever tool you
were using. To zoom out, add the
Option key [PC: Alt key), making the
shortcut Command-Option-Spacebar
[PC: Control-Alt-Spacebar).

® ® ® nNoRTHEHAND TOOL

Don't bother clicking on the Hand
ool in the Toolbox to scroll your
wiew, just hold down the Spacebar,
This will activate the Hand tacl so
you can scroll, then let go of the
Spacebar to continue with your
current tool. This works with all toals
except the Type tools. (There is a
trick, but you'll have to peek at the
text chapter.}
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® & & EasycuRVES

If you're new to drawing curves with the Pen toel, here's a quick method to create a simple
curve. Use the Pen tool to draw two straight lines that create an angle that points in the direc-
tion you want your curve, Then hold down Option (PC: Alt) to activate the Convert Anchor Point
tool, Click an the anchor point where the two lines meet and drag outwards to create 2 curve.

® O © KeepITSIMPLE

Ome of the basic nules of lllustrator
should be to use the minimum
numbser of anchor points that you
can get away with on a path. This
will keep your objects as simple as
possible, which will help streamline
the printing process. An easy way
to reduce the number of anchor
paints on a path is to select the
path and use the Simplify command
(Object=Path=5implify).
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® ® ® TtHAT'SOUTOF 100

By default, the value axis on a graph will be
slighthy more than the largest value in your data,
To sat a specific maximum value [such as 100),
select the graph and go to Object=Graph=Type.
In the dialog. choose Value Axis from the pop-up
menu, Check the Override Calculated Values box
and enter the maximum value (100 in my exam-
ple). iNate: The maximum value you chaase will
become the default, so be prepared to change it
back the next time you create a graph.)
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® & ® ADDTOASHAPE TO CREATE A SHAPE

Sometimes it's easier to create a simple shape and then
add to it with more anchor points. For example, to cre-
ate a map pointer, draw a rectangle with the Rectangle
tool and then use the Add Anchor Point tool to add
three anchor points along the bottom, Press "a” to get
the Direct Selection tool, then drag out the middle of
the three anchor points you added. There you have it!
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® © © CLOSEAPATH AUTOMATICALLY

To create a closed path with the Brush tool or the Pencil tool, start drawing, then hald down
Option (PC: Alt). Continue drawing, and when you're ready to have the path clesed for you,
let go of the mouse button. Once the path has closed, then release Option (PC: Alt).

® & ® ANGLED OBJECTS
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Rather than create objects and then rotate
them to a specific angle, here’s another
option. Before drawing any object, press
Cammand-K (PC: Control-K} to open the Praf-
erences dialog. In the Constrain Anagle field,
enter the angle at which you want objects

to be created. Click OK and every object you
create will be drawn at the angle you entered,
Once you've finished, go back to the Prefer-
ences and change the angle back to zero.
(This function does not change objects that
have already been created, only new objects.)
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® & & PERMANENT PATHFINDER

By default, clicking on the top row of icons in the Path-
fincder palette creates a “live” effect that can be adited.
Clicking on the Expand button makes the effect “per-

(T 1Ta i A
manent,” If you want to create a permanent effect right ..|:E IE 3
away, hold down Option (PC: Alt) as you click on the = ok
Pathfinder lcons of your choice, E B [O][S][7]
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' ® © TEAROFF TOOL MENUS

Any tool in the Toolbox that displays a small triangle in the

L_j bottom right-hand corner has a set of “hidden” tools that can

be accessed by clicking and holding on the current tool, Instead
of popping up hidden tool menus all the time, make your life
easier by tearing off commanly used tool menus. Just click-and-hold on the tool to pop up
the other tool choices, then drag over to the bar at the end of the tool menu. When you
release the mouse, the tool menu becomes a floating palette that you can position anywhere
you want.
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. e e SHAPES AROUND A CIRCLE

If you use a circular path for the Replace Spine command, chances are the objects in your
blend will not be evenly distributed areund the circle. There's a simple trick to make sure
the objects in your blend are evenly spaced around the circle: Select the path, and with the
Scissors tool click somewhere on the path of the circle to create an open path (don't move
anything, just click once to cut the path). The blended objects will automatically be distrib-
uted along the path. (Note: Try this forany path, not just circles.)
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® & ©® CHANGE THE BLEND

After you've created a blend (and it's still
“llve”), you can change the number of
steps in the blend by going to the Object
menu and choosing Blend=Bland
Optiens (or double-clicking the Blend
tool in the Toolbox). In the dialog,
change the number of Specified Steps
and the blend will update, An even
quicker way is to check the Preview
box and use the Up and Down Arrow
keys for an instant update.
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® © © DONTSELECT FIRST

This one's a little add since it breaks a “fun-
damental” rule of [llustrator: Make sure you

[ have selected all the objects you want o
work with, In the case of the command called
Divide Dbjects Below, it won't work if more
than cne object is selected, Simply create the
object that will do the dividing and pasi-
tian it over the other object(s] to be divided.
Select only the dividing object, then choose
Ohbject=Path=Divide Objects Below, {If you

have too many objects selacted, it won't
work and you'll get a warning dialog.)

® © © CHANGE GRIDS ONTHEFLY

By default, the Rectangular Grid tool, under the Line toal in the Toolbox, creates equal spac-
ing between the horizontal and vertical dividers. To change the spacing as you drag a grid,
tap “x"or “c” to move horizontal dividers left or right, tap “v" or °F to move vertical dividers up
-or down, [Here | tapped "c” as | dragged out the grid.}
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® © © THETRUE CENTER

When you use the Attributes palette (Window=Attributes) to show the center of a star, you'll
note that the center point isn't exactly centered (as shown below, left). Rather than try

to explain why this happens (which isn't really important since | can't change it), let's see
how to find the “true” center of a star. Select the object, then choose Edit=Copy and then
Edit>Paste in Front. From the Object menu choose Path>Average. In the dialog, click Both for
Axis, The point that appears Is the true center of the object,

® ® © BIGGER ORSMALLER A BIT AT ATIME

Perhaps you are trying to scale one object to fit within a second object, or you need to make
an object smaller, but you're not sure by how much, Try this method: With the object selected,
double-click on the Scale tool and enter 98% if you're scaling down, or 102% if you're making
it larger. That will scale the object 2% smaller or larger. (You can choose Copy from the dialog
to make a smaller or larger copy of your object, as | did in my example here.) Then press
Command-0 (PC: Centrol-D) to repeat the transformation. Each time you press this shortcut,
the object will scale by 2% (smaller or larger, depending on the value you enterad), allowing

you to scale a bit at a time.
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e @ B TRANSFORM BY NUMBER

| Rutate " With all transformation toals, such
——— a5 Scale, Rotate, and Shear, you can

; ~ transform manually by dragging the
o T

mouse—or numerically. Double-
- Options f E_ﬂﬂ )
v Objecis Pammrn:
JEE = W Previen

click on any transformation tool 1o
get a dialog for a numeric transfor-
mation. By default, the reference
point for the transfarmation is the
center of the object. But to open the
dialog and set a different reference
point, hold down Option (PC: Alt)
and click in the spot you'd like to use
as a reference point.

® & © FREETRANSFORM

Add all kinds of extra functions to the Free Transform tool by using a number of different keys

after you click on a corner handle, For example, press Command (PC: Control] as you click-and-
drag to distort; press Command-Option-Shift (PC: Control-Alt-Shift) to distort perspective; press
Command-Option (PC: Control-Alt) to shear an object; hald Shift ta scale; ete,
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® & & TRANSFORM AGAIN

Don't be fooled by the shortcut for this command: i  Rotate

Command-D (PC: Control-D). In many applica-

tions that's the shorteut for Duplicate, but not in Angle: [f@ |
lllustrator. In this program the command is called ==

Transform Again, and it's quite different from |

duplicating {in a very good way). Transform Again | r 'Efté’n;::nl T Panerns E
is a shorter way of saying "whatever you just did, | S eresien
do it again.” 5o if you just rotated an object 30
pressing Command-D (PC: Control-D) will rotate the ohject another 30°. The object will not
be duplicated unless that's part of the original transformation. For example, if you drag an
object with Option (PC: Alt) held down to move a copy, Transform Again will move another
copy the exact same distance and angle, This is an extremely powerful command that has
many uses! [Just remember not to do any additional operation, or you will alter your Transform
Again command.)

78 CHAPTER 3 - Selecting, Editing, and Transforming




® ® & strRaGHTCUTS

Here's a weird one: The Knife tool doesn't use the Shift key to
cut in a straight line. Although every other tool uses Shift as a
constraint for straight lines, with the Knife tool you hold down
Option (PC: Alt) to cut in a straight line. Use Option-Shift
(PC: Alt-Shift) to cut in a straight horizontal or vertical line,




® & © MAKE YOUR OWN PATTERNS

Anything you drag into the Swatches palette will become a pattern, but it takes a bit of plan-
ning to create a seamless repeating pattern. Start by creating a square with no stroke—pick a
fill color if you want your pattern to have a background. Draw the shape you wantin your pat-
tern, center it, and then copy it four times, lining up the center of one object on each corner
of the square. Select all the objects and click the Divide icon in the Pathfinder palette. With
the Direct Selection toal, select and delete the outer portions of the repeating objects until
you end up with just the square containing the shapes (as shown in the third square below).
Select all the pieces and drag them into the Swatches palette. Now you can use the pattern
swatch to fill any object.
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8 e e MOVE YOUR PATTERN

It's possible to transform only the pattern within an object without moving the object itself.
You do this with any of the transformation tools (Rotate, Scale, Shear, etc.) while holding

down the tilde (~) key. Keep the key held down as you transform—don't let go or the abject
will be transformed instead,




® & ® bpimimaces

A common approach to creating artwork in lllustra-
tor is to import a photegraph or a scanned image
{File=Place} and to trace over it. You can make this
pracedure a little easier by putting the placed im-
age on its own layer and then making it a template,
Use the Layers palette’s flyout menu to choose
Template, The placed image will automatically be
dimmed. To change the setting for the template,
double-click on the layer in the Layers palette to
open the Layer Options dialog. In the Dim Images
To field, enter a percentage. Then click an the
Create Mew Layer icon at the bottom of the Layers
palette and use your favorite creation tools to trace
over the dimmed image.




